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1. Important Information

Before you use the cutting plotter, please make sure that you have read
the safety precautions and instructions below.

Notes, Cautions, and Warnings
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2. General Information
2.1 Introduction

Our cutting plotters have been designed to produce computer-generated images
or perform contour cutting on sheets or rolls of vinyl media.
This manual covers the following models of TH/TS cutting plotters:
·TH/TS 740 for media width: 50mm(1.97”) ~ 770mm(30.3”)
·TH/TS 1300 for media width: 50mm(4.7”) ~ 1270mm(50”)

2.2 Package Items
The package of thecontents the items listed below, please check carefully.

If you find any item missing, please consult your local dealer for further assistance.
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2.3 View

2.3.1 Front view

1 Steel axes 2 Carriage
3 Roll holder 4 AC power connector
5 Power switch 6 Control panel
7 Pinch roller 8 Stand (optional)

More information please see the Floor stand guide video for better understanding.
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2.3.2 Left and right view

1 AC power connector 2 Power switch
3 Serial port 4 USB port
5 U disk reader

2.3.3 Control panel
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1 power light 2 set up light 3 operate light
4 info status zone 5 X Rightward button 6 Frontward button
7 Menu button 8 Enter button 9 Pause button
10 Menu button 11 Test button 12 Enter button
13 X,Y origin button 14 X Rightward button 15 Y Frontward button
16 X Leftward button 17 Y Backward button 18 Repeat cutting button
19 Pause button 20 Reset button 21 Test button
22 Repeat cutting button 23 X,Y origin button 24 Y Backward button
25 X Leftward button 26 info status zone
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3. Set up your cutting plotter

3.1 Stand (optional)

CAUTION: Must use M5*45 screws with washers.
Must use M5*10 screws to fix the cutting plotter to the stand.
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3.2 Connect your cutting plotter

3.2.1 Connect the AC cable

Insert power supply cable plug into the AC connector ,and then push the power button.

Then the machine is power on.

3.2.2 Connect the USB cable (optional)

If you want to use the USB cable, you have to install the USB driver.

1. Find the following files from the CD, Double-click CDM20814_Setup.exe

2. connect computer by USB cable，it will display ‘ Found New Hardware’ as follow window.

33.Click “NEXT”
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4. Click “Finish”
○5 ．If driver was installed successfully，You can find a new port in Device Manager,
shown as below

if you want to modify the default port No. of USB driver, just right-click port（COM3）as
shown above, and select “Properties” in context menu.
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Select “Advanced…”,

Select the Port Number if you want to modify, then press “OK”

3.2.3 Connect the RS-232 cable (optional)
When you want to connect the RS-232C cable, you must observe the following notes

NOTE: (1)When connecting the cables, turn off first the power to the device and
that to the host computer which the power cable is to be connected.

(2) Do not plug in or unplug any cable during data transferring.
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3.3 Blade installation
Figure 3-1 and 3-2 are the drawings of the blade holder.

Figure 3-1 Figure 3-2

How to install a blade

(1) Remove the blade sheath by rotating it.
(2) insert the blade into the hole of the blade holder.
(3) Adjust the blade tip to suitable length by rotating the adjusting knob and blade sheath

clockwise or count-clockwise.

OK The length of blade is not enough The length of blade is too long
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NOTE: The suitable length means the blade’s length is adjusted 0.1mm more than
film’s thickness and it can completely cut through the film layer yet avoid
penetrating the base paper.

3.4 Blade holder installation
Install the blade holder into the tool holder of the carriage, press the brim of the blade

holder against the tool holder. rotate the knob of the tool holder clockwise and surely fix it.

NOTE: Fix the tool holder firmly. If not, accurate and high-quality cutting will not be

achieved.

3.5 loading a sheet
Either a piece of sheet or a roll of sheet can be loaded on the plotter.

Figure 3-3 Figure 3-4
(1) Lift the lever to rise the pinch rollers. (see Figure 3-3)
(2) Load the sheet and slide to under the pinch rollers form either the front side or backside.

The alignment ruler on the platen will help you to adjust the sheet precisely.
(3) Slide the pinch rollers manually to the proper position. Be sure the pinch rollers must be

positioned above the steel axes. The red mark on the top trail will remind you where the
steel axes are.

(4) Press the lever to lower down the pinch rollers.(see Figure 3-4)
(5) Double pressure setting button can set the pinch roller fixed the thickness
material well

NOTE: If you want to cutting a sheet without a reversed adhesive paper (like a
pasteboard),You should use a sticker sheet under it.

CAUTION: Move the pinch roller by applying force at the rear portion of the pinch
roller support. Do not move it by holding its front rubber roller.

Double
pressure
button
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4. Basic Operations

4.1 Pressure Test
It will help you to know the conditions of the blade.

Press the or button, it will cut a rectangle on material, shown as above, Check
whether the rectangle can be completely teared off or not in order to make sure the right
pressure and the length of the blade tip

NOTE: When the cutter blade is worn and dull, you can use it temporarily by
enhancing the value of PRESSURE. However, you are recommended to replace
the worn cutter blade with a new one to ensure a satisfactory cutting quality.

4.2 Pressure and Speed

(1) Press or button goes to the interface in

which F100 is the pressure 100g，V500 is the speed 500mm/s.
(2)

Pressure
or Decrease the pressure Once for 5

Min is 5

or Increase the pressure Once for 5
Max is 500*

Speed
or Decrease the speed Once for 25

Min is 50

or Increase the speed Once for 25
Max is 500

(2) After adjusting the Pressure or Speed, press or to save the settings.

4.3 Languages and Baud rate

(1) Press or button to goes to the interface , and

then press red button one time to go to the interface
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Language
or Switching between Chinese

and English
or

Baud rate or
Switching Between 38400
and 56000

or

Then press or to save the settings.

NOTE: To ensure it works, the baud rate of cutter must be the same as the software on
computer.

4.4 X, Y axis scale

(1) Press or button goes to the interface

And then press goes to the interface

which SX0 is the proportionality factor of X axis; SY0 is the proportionality factor of Y
axis. Factor default is 0, if there is an error in the plotter, You can adjust them.

X axis
or

Decrease proportion of X
axis

or
Increase the proportion of X
axis

Y axis
or

Decrease the proportion of Y
axis

or
Increase the proportion of Y
axis
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(3) Then press or to save the settings.

NOTE: The value of the axis scale depends on the actual situation.

4.5 Distance between red dot and pen
(1) Press or button goes to the interface

Press to go to the interface

.

(2) Fix the sheet and pen in machine, and press the pen manually to make a dot on the material.

(3) Press or button, LCD will display interface .and the

carriage will give a red dot in material.

(4) Press 4 arrow Keys , , , , to move the red dot to the center of the dot just

made by pen, (total central overlapped)

(5) Then press or to save the settings.

NOTE: The settings will be stored in plotter all the time until you clear it.

4.6 Test the distance between red dot and pen
To test the distance from laser to pen is exact or not

(1) Press or button one time and then press goes to the

interface, press several times to go to this interface

Fix the sheet and pen and press pen to make a
dot on the sheet.

(3) Press or button, the red dot will locate the dot automatically, if the red dot
don't aim at the dot, It needs to be reset.
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4.7 Skin of LCD and Step distance of jog motion

, , , are continuous motion keys.

, , , are jog motion keys, You can set the distance of motion here, default is

5.0mm.

(1) Press or button goes to the interface
And then press to go to this interface

Skin
or Change the skin of LCD,

there are 6 skins available
or

Distance of
motion

or
Decrease the distance of
motion, the min is 0.1mm

or
Increase the distance of
motion, the max is 100. 0mm.

(3) Then press or to save the settings.

4.8 Cutting from FLASH
The plotter has a built-in FLASH, Every file sent by computer will be saved in the built-in
FLASH automatically. If it powered off, the file will not be lost, you can reuse it for cutting and
no need to be sent by computer again.

(1) Press or goes to the interface

(2) Press or will continue processing the last working file.

4.9 Cutting from U disk
The plotter can cut a file from U disk , the format of the file should be .PLT.

(1) Copy the .PLT format file to U disk, Insert the card into the plotter.

(2) Press or two times to go to the screen .

(3) Press or goes to the screen .
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(4) Press , , , to find the file you want to cut, it will display the file name

(5) Press or , the machine starts working.

4.10 Times of repeat cutting
When you cut files from FLASH or U disk, you can set the times for repeat cutting

(1) Press or button to

And then press several times to go to goes to the screen .

(2)

NOTE: The default is 1 time, Max is 500 times.

4.13 Pause and Cancel during operating

(1) During operating, press or , the screen will change to

operating
, press or again, the plotter will continue

Numbers of Copy

or

or

Increase the times of repeat
cutting

or

or

Decrease the times of repeat
cutting
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(2) In Pause status, press or will cancel the current job.

4.14 Origin button

5. Advancedoperations

5.1 Cut in FlexiSTATER Edition
(1) Install the software
(2) After finishing the installation, run the Production Manager, Click “Setup”->”Add

setup…”.

(3) Select the names of brand and model upon your plotter, and click “Next”
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(4) Set parameters as below:
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(5) Click “Finish”.

5.2 Output from AutoCAD

5.2.1 Add a plotter

(1) Click the main menu-> “Print” -> “Manage Plotters”
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(2) It will display “Plotters” window, double click “Add-a-Plotter Wizard”.
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(3) It will display the following dialog box, click “Next”.

(4) Select “My Computer”, and then click “Next”.
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(5) Select “Hewlett-Packard” for Manufacturers and “Generic SHPGL” for Models, and
then click “Next”.

(6) Click “Next” in following dialog box.
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(7) Select “Plot to File”, and then click “Next”.

(8) Enter a name for plotter, and then click “Next”.
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(9) Click “Edit Plotter Configuration” to set the parameters.

(10) Select “Custom Paper Sizes”, and click “Add…”.
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(11) Select “Start from scratch”, and then click “Next”.
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(12) Enter the appropriate value for Width and Height according to your plotter, and click
“Next”.

(13) Enter the value for the non-printable area, and then click “Next”.

(14) Enter a Paper Size Name, and then click “Next”.
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(15) Enter a PMP File Name, and then click “Next”.

(16) Click “Finish”.
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5.2.2 How to output

(1) Finish the file that you want to output.
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(2) Click main menu -> “Print”.

(3) Select the plotter and paper size that you just set (See P32-5.4.1), and select “Plot to
file” checkbox and “Custom” for Scale. Then click “Preview”, If It can’t plot normally,
please modify the settings, and finally click “OK”.
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(4) Select the location that you want to store and enter a name for the file, then click
“Save”.

(5) Run the AutoCAD output software in Teneth CD

(6) Select the appropriate Port and Baud rate,
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(7) Click “Browse…” to locate the .plt file you just saved.

(8) Click “Start” to do the task or click “Save as…” to save the file to a SD card or USB
Flash Disk.

5.3 Cut 5mm or smaller letters
To achieve the best quality output, we suggest you use a narrow sheet. If use wide sheet,
you should:
(1) Position two pinch rollers as close as possible to both edges of the cutting area.
(2) Make sure the loaded sheet is placed the flat with equal tension.
(3) Set parameters as below:

○1 In Flexi:
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○2 In ARTCUT:
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6. Addtional parts
Find More Information and Resources.
Please visit our Website:
If you have any questions, please contact us or email to
Information in this document is subject to change without notice.

Reproduction of these materials in any manner whatsoever without the written permission of
Teneth lnc. Is strictly forbidden.

Contour Cut (optional)

1. Create or open a graphic file in Flexi, and click “Effects”->”Contour Cut…” to

create a contour.

2. You can adjust related parameters in “DesignCentral” pop-up window, and then

click
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3. Click “Effects”->“Contour Cut Mark…” to add a contour cut mark for the graphic

file.

4. Select “4 Point” in “DesignCentral” pop-up window, and then click .
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5. Click file “File” -> “Print” to print the graphic file.

6. In the “Print” window, there are some print options for your choice (e.g., if you

want to print original size, just select “100cm = 1m [100%]”)
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7. Load the printed sheet on the plotter, and click file “File” -> “Cut Contour…”

CAUTION:

CAUTION: When loading the sheet, Be sure the red dot must be placed at the right

side of first point, otherwise the plotter will not work normally, the valid zone is

as shown below:
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8. In “Cut Contour” window, select your plotter model, and click “Options” tab ->

“Edit…”button.
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9. It will pop up a dialog box, please set the parameters Offset X 0.00mm, Offset Y

0.00mm as below, and click “Apply”-> “OK”.

10. Then click “Send”, It will pop up a “Alignment” dialog box in “Production

Manager” window, select “Interactive alignment (Manual)”,and click “OK”.

11. It will popup the first point dialog box, make the red dot of the plotter aim at

the

center of the mark by clicking 4 arrow keys, and then click “OK”.
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12. Then it will popup the second point dialog box, and At the same time, the red dot

moves to the second point automatically, make the red dot of the plotter aim at the

center of the second mark by clicking 4 arrow keys, and then click “OK”.

13. The operations for the third and fourth points are similar as above.
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14. Then it will pop up a dialog box as blow, press Origin button on control

panel of plotter. And then press “OK”, the plotter will perform the contour cut.


